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What is gret!?

i @ &8 & =

gretl is an acronym for Gnu Regression Econometrics and
Time-series Library

it 1s free econometrics software

it has an easy Graphical User Interface (gui)
it runs least-squares, maximum-likelihood, systems estimators...

it outputs results to several formats

very important for us in this course: it admits scripts (sequence of
commands saved ina file)



Howdo I get gretl?

Handy for remote learning since it is open-source free software
anyone can install it on home desktop without the need of license

In order to install it go to:
http://gretl.sourceforge.net

It runs on Windows, Mac, Linux
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http://gretl.sourceforge.net/

X

Installation

Open the webpage and go down where Download section is located.
Click on the circled button for windows users

+

ot secure

gretl.sourceforge.net

« Support for machine learning via LIBSVM (details)

Besides gretl's core functionality, several addons and numerous contributed function packages are avail
below.

Data formats

Supported formats include: own XML data files; Comma Separated Values; Excel, Ghnumeric and Open C
files; SPSS .sav files; Eviews workfiles; JMulTi data files; own format binary databases (allowing mixed
lengths), RATS 4 databases and PC-Give databases. Includes a sample US macro database. See also tht

Download

The current source package gret|-2020d.tar.xz

Debian GNU/Linux packages, maintained by Dirk Eddelbuettel packages.debian.org; see also packages
Fedora packages, maintained by Johannes Lips apps.fedoraproject.org

Whether you're compiling from source or installing a pre-compiled binary, you may want/need to check

Gretl for MS Windows can b found here, and Jretl for Mac OS X here.

The time-series analysis programs X-L5-ARIMA and TRAMO/SEATS are available in a form suitable for u

o
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N
Installation

Choose the .exe file which is appropriate for your system

gretl for Windows x |+

&« O O Notsecure | gretl.sourceforge.ne

B % * @
[gret! main page]

Gretl: Gnu Regression, Econometrics and Time-series Library
for Microsoft Windows

System requirements

A5 of version 1.9.4, gretl requires Windows XP or higher and a processor that supports the SSE2 Instruction set. SSE2 support Is found In all modern processors; It Is absent In AMD CPUs prior
Athlon 64, and In Intel CPUs prior to the Pentium 4. For versions of gretl that will run on older systems, ses balow.

Downloads
If you have the rights of a "power-user” or better on Windows, choose a self-Installer from the first or second column below; just download and run the exe file. This applies to most people.
If you have no administrator rights on Windows choose a zip archive from the third column; unzip this in any location where you have write permission. Note: you must preserve the intemal ¢

structure of the archive or gretl will not work. In unzipping programs this option may be called "enable folders”. The whole archive is in a directory called gretl. For example, If you unzip the 2
into a directory named c:\userdata, the gretl GUI program will be at c:\userdata\gretL\gretl . exe.

The current "snapshot” of gretl s more up to date than the release: often it will contain bug-fixes but sometimes it will contain newly introduced bugs. To see what's new in the snapshot, take
at the Change log (the "In progress” entry).

Note: the 32-bit version of gretl will run on 64-bit Windows, but not vice versa. If you're not sure If your Windows Installation Is 64-bit or not you can check at the Microsoft knowladge base.

self-instalier (32-bit)

-bit) OR zip archive (no admin rights)
latest release (Aug 6, 2020) gretl-2020d-

OR current snapshot

The executables were cross-compiled under GNU/Linux using mingvi-w64. The free installer program Is courtesy of Jordan Russall.
Optional extras you may wish to install

X-13-ARIMA-SEATS (seasonal adiustment. ARIMA modals) x13as install.exe OR (64-bit) x13as install-64.exe

>
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Installation

Run the .exe file and choose default options to proceed. Do not
forget to add gretl directory to your PATH

m% Setup - gretl version 2020d (x86_64) — X

Select Additional Tasks
Which additional tasks should be performed?

Select the additional tasks you would like Setup to perform while installing gretl, then
click Next.

Add gretl directory to your PATH >




Start gretl

To start gretl you can just type gretl in your search button. Select
it and an empty gretl window will pop out. You can either run
commands directly in the gretl console or write scripts and save
them for future use -
B¥oret

File Tools Data

O >

Model Help =

CA\Users\dalihDocuments\gret|

No datafile loaded
<

ID # 4 Variable name 4 Descriptive label

Gretl Gretl
scripts console

\-EII /'I" i“’ > 5 1= & a B
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How do ['work with gretl?(1/2)

w the easiest way for beginners is by using its graphical user interface
m you can also use the console button of the toolbar: from the prompt (?)
you can execute gretl commands one line at a time.
w the most efficient way is by usingscripts:
¥ create a script file, write gretl commands one every line, and save it
¥ run the script using the gui

E¥ inspect output
¥ ifneeded, change script file, save it, and go back to step 2



Running commands in the script

Click CTRL + R or click the button shown below. The window with
outputs (or errors) will open. If you save these scripts, it will be
saved as .inp file.

B aEE & 0 S B e Eos=H8

ols wage educat

| “ gretl: untitled — O x




How do ['work with gretl?(2/2)

you know your way using the gui, but want to know about scripts...

I gretl comes with over 70 practice scripts

the manual gives good advice and devotes several chapters to provide
P good programming solutions

@ this course will provide you with tested scripts
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-
Opening datasets

O Gretl comes with inbuilt datasets which you can play with

U Go File -> Open data -> Sample file and this will give you lots of
datasets, or alternatively, go to specific data file which you want
to access in your computer by choosing User file instead of
sample file gy

Eile| Tools Data View Add Sample Variable Model Help
Open data 4 User file... Ctrl+0 | !
bppencicaas =) Samplefile...
E Save data Ctrl+S
- R 1. beer.gdt
@ Save data as..
§ < P 2. data3-1.gdt
j“‘n tosla 3. collegetown.gdt
& Send To.. 4, data3-4.gdt
|_] New data set Ctrl+N 5. wgmacro.gdt
& 6. bachelor.gdt
Working directory...
Script files 4
Session files L
Databases »
Function packages L4
Resource from addon >
ol Quit Ctrl+Q 12/33




-
Opening datasets

U If you want to open file which has a different extension, for example
excel, when you go to User File, do not forget to set it for excel
searching, otherwise nothing will be shown in the window

aretl: open file
) Recently Used

Places
\ Search
|5 gretl
[ dalil
[ Desktop
£ Windows (C:)

Name
& beer.gdt

4 Size Modified bad
25kB Yesterday at 14:10

Gretl datafiles (*.gdt, *.gdtb)
CSV files (.csv)

ASCI| files (*.txt)

Grumeric files (*.gnumeric)
Open Document files (*.ods)
Excel files (".xls)

Excel files (*.xlsx)

Stata files (*.dta)

Eviews files (*.wf1)

SPSS files (*.sav)

SAS xport files (*.xpt)

IMuITi files (*.dat)

Shapefiles (*.shp)

GeolSON files (*.geojson, *json)
all files (*.%)

Gretl datafiles (*.gdt, *.gdth)
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Opening datasets

QO For now let’s open a Sample file the very first one offered
‘abdata’ by double-clicking it with a mouse

gretl: data files - O X

E 0 & &
I Gretl Greene Ramanathan

File 4 Summary 4 Type 4

abdata Arellano and Bond (1991) panel data panel, T=9 N=140
1| anscombe Anscombe's Quartet (artificial data) cross section, n=11

arma Artificial data for ARMA script example time series, T=624

australia Johansen's Australian macroeconomic data time series, T=77

AWM Euro area macroeconomic data, 1970-1998 time series, T=116

AWM17 Euro area macroeconomic data, 1970-2016 time series, T=188

AWM18 Euro area macroeconomic data, 1970-2017 time series, T=192

banks91 Costs of Italian commercial banks cross section, n=198

b-g Bollerslev and Ghysels exchange rate data time series, T=1974

bjg Box and Jenkins Series G (airline passengers) time series, T=144

brand_cassola Eure area money demand data time series, T=79

broiler Epple and McCallum broiler chicken data time series, T=52

CEL Caselli, Esquivel and Lefort growth panel data panel, T=8 N=97

chomage D.S.G. Pollock's Swiss unemployment data time series, T=66

rredecars Grecne'e rredit crnrinm data rroce cactinn =100 v
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Playing with data

The following window will pop out. You can now check the values
of each variable by double clicking them. You can edit them etc.

gretl — O X
File Tools Data View Add Sample Variable Model Help 'd"\
abdata.gdt C\Users\dalil\Documents\gretl
ID# 4 Variable name 4 Descriptive label 4

0 const

2  YEAR year of observation (1976 to 1984)

3 EMP U.K. employment in company i at end yeart

4  WAGE real product wage

5 CAp gross capital

6 INDOUTPT industry output

7 n log of employment

8 w log of real product wage

9 k log of gross capital

10 ys log of industry ocutput

11 unit individual (firm) index
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Operations on variables

U See summary statistics of variables by highlighting them and
clicking Variable -> summary statistics in the upper panel

U Change values of variables by highlighting it and clicking Data ->

Miew Add Sample Variable Model Help

Select all

Display values
Edit values
Add observations...

Edit values
File Tools
Examplel.x||
ID# |Vari

0 con
1 YEA|
2 unit|
B EMF

Dataset info
Observation markers...

Dataset structure...

Transpose data...
Sort data...

Set missing value code...

Count missing values

Find variable...
Refresh window

Ctri+A

Ctri+F

Undated: Full range 1 - 900

m L FxBDOL R
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Saving as gretl File

Saving as a new gretl File

You can open any other type of file using gretl (excel), do some operations on them
and then save as a gretl file (.gdt) by clicking: File -> Save Data as -> Standard

format

<« gea  =2=EH

[l Tools Data View Add Sample Variable Model Help

Open data
Append data
Save data
Save data as
Export data
Send To...

Clear data set

Script files
Session files
Databases
Function files

Exit

Working directory...

YVYYY

Crri+X

\ve label

erated constant

Standard format... h
Database...

Undated: Full range 1 - 900

W] F s BOL 2=
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Running a Script

Looking at the Session Script

Tools > Command log displays the operations that we have done so far

£ gretl =T
gata View Add Sample Variable Mode

Exan|  statistical tables

ID#|  Pp-value finder el
0|  Distribution graphs d constant
; Plot a curve
3 Test statistic calculator

Nonparametric tests
Seed for random numbers

Command log [}
Gretl console

Start GNU R

NIST test suite >
Preferences >

Undated: Full range 1 - 900
W B@ L S
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More on scripts

w using File/Script files/New script you open the command script editor

w Ifyouhave a very long command that exceeds one line, use the
backslash (\) as a continuation command

m using scripts (and the console) requires you to use the correct
language syntax

m gretl's language is case sensitive: gretl considers x to be different
from X

@ youcan find all the commands in the gretl command reference after
clicking Help -> command reference

w at the console window, you can type help
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Exercise 1

* Load the file engel.gdt. The data set contains two variables
named income and foodexp. The variable foodexp is annual
expenditures on food in a household and income is annual income
measured in $100 increments.

» Using GUI, display logs of both variables.

» Using GUI, plot foodexp againstincome.

*  Write all the commands in a script file and save
it. Open the script and run the commands.

* Save the new dataset.

N



First Exercises

Exercise 2

The file BWGHT.csv contains information about infants' birth weight, sex
and race, the income of their faimilies, their parents' education and the
number of cigarettes the mother smoked per day during pregnancy (msmoke).

@ Import from gretl the file BWEIGHT xlIsx

B Compute the average birth weight for all the babies in the sample, and
separately for boys and girls.

B Compute the proportion of mothers that smoked during pregnancy.

@ Which familiy variables do you think are related to children's birth
weight? Compute the correlation among bwght and those variables.

B Save the new database in gretl format.

@ Write down all the previous commands in a script and save it. Close
your session, open the script and run all the commands together.
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First Exercises

Basic commands for data management (1/2)

Commands on the entire data
® open: opens a data file replacing any data file already open
# smpl: defines the sample range
® dataset: sorts/clears/transposes/adds observations and more
[

setobs: declares the structure of the data (cross-section, time-series,
panel)

w append: appends the content of a data to the current dataset

m store: saves the data into a file
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First Exercises

Basic commands for data management (2/2)

Basic commands on variables

genr: creates a new variable

delete: removes variables

setinfo: sets attributes of a variable

rename: renames a variable

summary: shows summary statistics for variables

print: lists the values of variables




Commands on Datasets

smpl (#start #end | condition ——restrict | # —-random |
full) ——replace ——balanced

m condition ——restrict: restricts the sample to observations that satisfy
the condition

w # —-random: # cases are ramdomly selected
w full: restores the full data range

w sample restrictions are by default cumulative: ——replace turns o ff all
previous restrictions

s

Examples (using Example2.xls)
# smpl YEAR!=1976 ——restrict
w smpl EMP > 3 ——restrict ——replace

w smpl 50 ——random
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Commands on Datasets

dataset (addobs # | transpose | sortby varname | resample
# | clear)

w addobs: adds extra observations at the end
@ transpose: transposes current data set.

w sortby: sorts data by varname (dsortby: descending order) (a list of
variables can be provided; available only for undated data).

w resample: random sampling (Constructs a new dataset by random
sampling, with replacement, of the rows of the current dataset. The
original dataset can be retrieved via the command smpl full).

w clear: clears out current data

Examples
@ dataset sortby EMP

@ dataset resample 500

@ dataset clear




Commands on Datasets

setobs unitvar timevar ——panel-vars

® imposes a panel interpretation

m sorts data as stacked time series, by ascending values of unitvar

Examples
m setobs 1 1 ——cross-section
@ setobs 20 1:1 ——stacked-time-series

@ setobs unit year ——panel-vars

26/33



Commands on Datasets

append newdata ——time-series

m opens a data file and appends the content to the current dataset
w First case: additional observations for existing variables
m Second case: new variables (best if # obs compatible)

w Third case: appends a time series in a panel

First Case
# open C:\there\Example2.xIs ——sheet= first100
® append C:\there\Example2.xls ——sheet= moreunits

¥ appends worksheet moreunits fromC:\there\Example2.xls

Second Case
¥ append C:\there\Example2.xls ——sheet= wages

¥ appends worksheet wages from C:\there\Example2.xls




Commands on Datasets

store data le [varlist] ——gzipped ——overwrite

m bydefault data saved in gretl format
w also exports to csv (using ——csv) and other formats

store C:\there\mydata.gdt

m saves current data to C:\there\mydata.gdt
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Commands on Variables

[genr] newvar = formula

w a formula is a well-formed function of variables

m the range over which the result is written depends on the current
sample

w arithmetical operators: ~, *,/, + , -

w boolean operators: ! (negation), && (AND), || (OR), >, <, =, >= |
<= ,1=

w look at the gretl Function Reference (Help/Function Reference) for
built-in functions

Examples

w genry= 3+ 2*xl+ 5*x2+ error
g D1976 = (YEAR = 1976)

w genr avgy = mean(y)
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Commands on Variables

delete [ varlist ] ——db

w removes listed variables

m ifno varlist is given, it deletes the last (highest numbered) variable
from the dataset

mw ——db: deletes variables from a gretl database
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Commands on Variables

rename varname newname

® changes the name of the variable
@ names must be of 15 characters maximum

w they must start with a letter

w they must be composed of only letters, digits, and the underscore
character

Example in bwght.gdt
® rename bwght birth weight




Commands on Variables

summary [ varlist | ——simple ——by=byvar

® prints summary statistics for variables in varlist
w ifvarlist is omitted, it prints statistics for all variables

m ——simple: only prints the mean, minimum, maximum and standard
deviation

w ——by=byvar: statistics are printed for sub-samples defined by the
values taken on by byvar

Example in bwght.gdt
@ summary bwght
® summary bwght ——simple
@ summary bwght ——simple ——by=male

@ summary bwght ——simple ——by=parity
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Commands on Variables

print [varlist] ——byobs ——no-dates

m prints the values of the variablesin varlist
w if no list is given, prints the values of all variables
m ——byobs: data are printed by observation, not by variable

@ you can also printstrings

Examples
@ print bwght male ——byobs

@ print bwght ; male ——byobs :

@ print "This isa comment"




